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Preface Welcome to the Network Simulation Experiments Manual, 2nd Edition. As networking systems have become more complex and expensive, hands-on experiments based on networking simulation have become essential for teaching the key computer networking topics to students and professionals. The simulation approach is highly useful because it provides a virtual environment for a variety of desirable features such as modeling a network based on specified criteria and analyzing its performance under different scenarios. This manual has 15 laboratory experiments that cover a variety of networking designs and protocols. The experiments in this manual do not require programming skills as a prerequisite. They are generic and can be easily expanded to utilize new technologies and networking standards. With the free easy-to-install software, the OPNET IT Guru Academic Edition, networking students and professionals can implement the experiments from the convenience of their homes or workplaces. The manual is suitable for a singlesemester course on computer networking at the undergraduate or beginning graduate level. Professors can pick the experiments that are appropriate to their class. The new materials in the 2nd edition of the manual are: ƒ A new Prelab Activities section in every laboratory assignment. This section includes recommended readings from the textbook as well as references to animations from the Net-SEAL project (www.net-seal.net)1. These activities are intended to reinforce the student’s understanding of the concepts related to the topics covered in the laboratory. ƒ Two new laboratory experiments to cover wireless networking protocols. ƒ One new laboratory experiment to cover the Border Gateway Protocol (BGP). ƒ A new component to address the ICMP protocol has been added to the RIP lab. ƒ A new component to address the effect of encryption has been added to the VPN lab. OPNET IT Guru Academic Edition provides a virtual environment for modeling, analyzing, and predicting the performance of IT infrastructures, including applications, servers, and networking technologies. Based on OPNET's award-winning IT Guru product, Academic Edition is designed to complement specific lab exercises that teach fundamental networking concepts. The commercial version of IT Guru has broader capabilities designed for the enterprise IT environment, documentation, and professional support. OPNET software is used by thousands of commercial and government organizations worldwide, and by over 500 universities. For more information, visit www.opnet.com. OPNET and IT Guru are trademarks of OPNET Technologies, Inc. I would like to extend my appreciation to Professor Larry Peterson and Dr. Bruce Davie for giving me the opportunity to associate the laboratory experiments of this manual with their valuable book. I want to thank the folks at Morgan Kaufmann who have helped to bring this project to life. Many thanks to the reviewers, from academia and OPNET, who read through the various drafts of the experiments and provided me with extremely valuable feedback. My gratitude to the Net-SEAL project team, with special appreciation to Neal Charbonneau for the superb job he did in the project. I want to thank my family for their consideration and enthusiastic assurance throughout the development of this project. Last, but not least, I want to thank you for choosing the manual. I welcome your emails to report bug or to suggest improvements.



Emad Aboelela, Ph.D. [email protected] University of Massachusetts Dartmouth July 2007
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The materials in the www.net-seal.net website are based upon work supported by the National Science Foundation under Grant No. DUE-0536388. Any opinions, findings and conclusions or recommendations expressed in this website are those of the Net-SEAL project team and do not necessarily reflect the views of the National Science Foundation (NSF).
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Laboratory



0



Introduction Basics of OPNET IT Guru Academic Edition Objective This lab teaches you the basics of using OPNET IT Guru Academic Edition. OPNET IT Guru Academic Edition enables students to better understand the core concepts of networking and equips them to effectively troubleshoot and manage real-world network infrastructures.



Overview OPNET’s IT Guru provides a Virtual Network Environment that models the behavior of your entire network, including its routers, switches, protocols, servers, and individual applications. By working in the Virtual Network Environment, IT managers, network and system planners, and operations staff are empowered to diagnose difficult problems more effectively, validate changes before they are implemented, and plan for future scenarios including growth and failure. OPNET's Application Characterization Environment (ACE) module for IT Guru enables enterprises to identify the root cause of end-to-end application performance problems and to solve them cost-effectively by understanding the impact of changes. In this lab, you will learn the basics of the OPNET IT Guru Academic Edition software. You will learn how to setup and run OPNET IT Guru Academic Edition. You will become familiar with some of its capabilities by running some tutorials. The labs in this manual are implemented with OPNET IT Guru Academic Edition release 9.1.A (Build 1997). If you want to download the software, please visit the following site to register with OPNET technology: www.opnet.com/university_program/itguru_academic_edition/ Recommended System Configuration, Platforms, and Software: -



1.5 GHz processor or better 512 MB – 2 GB RAM 1 GB disk space Display: 1024 x 768 or higher resolution, 256 or more colors Adobe Acrobat reader. The English language version of the following operating systems are supported: • Microsoft Windows NT (Service Pack 3, 5, or 6a)
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• •



Windows 2000 Professional (Service Pack 1, 2, and 4 are supported but not required) Windows XP (Service Pack 1 is required; Service Pack 2 is supported but not required.)



Prelab Activities







Read Chapter 1 from "Computer Networks: A Systems Approach", 4th Edition. Go to www.net-seal.net/animations.php and play the following animation: - No Network.



Procedure Start OPNET IT Guru Academic Edition To start OPNET IT Guru Academic Edition: 1. Click on Start Ÿ Programs Ÿ OPNET IT Guru Academic Edition x.x Ÿ OPNET IT Guru Academic Edition, where x.x is the software version (e.g., 9.1). 2. Read the Restricted Use Agreement and if you agree, click I have read this SOFTWARE AGREEMENT and I understand and accept the terms and conditions described herein. Now you should see the starting window of OPNET IT Guru Academic Edition as shown:



3



Introduction



Check the OPNET Preferences The OPNET Preferences let you display and edit environment attributes, which control program operations. In this lab you will check three of these attributes. 1. After starting OPNET, from the Edit menu, choose Preferences. 2. The list of environment attributes is sorted alphabetically according to name. You can locate attributes faster by typing any part of the attribute’s name in the Find field. 3. Check the value of the license_server attribute. It has the name of the License Server’s host. If IT Guru is getting its license from the local host (i.e., the computer on which the software was installed), the value of license_server should be localhost as shown in the following figure. 4. Set the license_server_standalone attribute to TRUE. This attribute specifies whether the program acts as its own license server. 5. A model directory is a directory that contains OPNET model files. If the directory is listed in the mod_dirs environment attribute, then OPNET programs will use the models in that directory. Check the value of the mod_dirs attribute. The first directory in the list is where your own models will be saved. In the future you might need to access that directory to back up, copy, or move your models. IT Guru saves numerous files for every single project you create. 6. Click OK to close the dialog box.
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Run the Introduction Tutorial Now you will run the introductory tutorial that teaches you the basics of using OPNET IT Guru. 1. From the Help menu, select Tutorial. 2. Go over the Introduction lesson from the list of Basic Lessons.



Run the Small Internetworks Tutorial In this tutorial you will learn how to use OPNET IT Guru features to build and analyze network models. 1. From the Help menu, select Tutorial. 2. Carry out the Small Internetworks tutorial from the list of Basic Lessons.



Exercises 1) In the project you created for the Small Internetworks tutorial, add a new



scenario as a duplicate of the first_floor scenario. Name the new scenario expansion2. In the expansion2 scenario expand the network the same way as in the expansion scenario but with 30 nodes in the second floor instead of 15 nodes. Run the simulation and compare the load and delay graphs of this new scenario with the corresponding graphs of the first_floor and expansion scenarios.



Lab Report The laboratory report of this lab (and also all the following labs in this manual) should include the following items/sections: -



A cover page with your name, course information, lab number and title, and date of submission.



-



A summary of the addressed topic and objectives of the lab.



-



Implementation: a brief description of the process you followed in conducting the implementation of the lab scenarios.



-



Results obtained throughout the lab implementation, the analysis of these results, and a comparison of these results with your expectations.



-



Answers to the given exercises at the end of the lab. If an answer incorporates new graphs, analysis of these graphs should be included here.



-



A conclusion that includes what you learned, difficulties you faced, and any suggested extensions/improvements to the lab.



Laboratory
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Ethernet A Direct Link Network with Media Access Control Objective This lab is designed to demonstrate the operation of the Ethernet network. The simulation in this lab will help you examine the performance of the Ethernet network under different scenarios.



Overview The Ethernet is a working example of the more general Carrier Sense, Multiple Access with Collision Detect (CSMA/CD) local area network technology. The Ethernet is a multiple-access network, meaning that a set of nodes sends and receives frames over a shared link. The “carrier sense” in CSMA/CD means that all the nodes can distinguish between an idle and a busy link. The “collision detect” means that a node listens as it transmits and can therefore detect when a frame it is transmitting has interfered (collided) with a frame transmitted by another node. The Ethernet is said to be a 1-persistent protocol because an adaptor with a frame to send transmits with probability 1 whenever a busy line goes idle. In this lab you will set up an Ethernet with thirty nodes connected via a coaxial link in a bus topology. The coaxial link is operating at a data rate of 10 Mbps. You will study how the throughput of the network is affected by the network load as well as the size of the packets.



Prelab Activities







Read section 2.6 from "Computer Networks: A Systems Approach", 4th Edition. Go to www.net-seal.net/animations.php and play the following animation: -Hub.



6



Network Simulation Experiments Manual



Procedure Create a New Project To create a new project for the Ethernet network: 1. Start OPNET IT Guru Academic Edition Ÿ Choose New from the File menu. 2. Select Project Ÿ Click OK Ÿ Name the project _Ethernet, and the scenario Coax Ÿ Click OK. Local area networks (LANs) are designed to span distances of up to a few thousand meters.



3. In the Startup Wizard: Initial Topology dialog box, make sure that Create Empty Scenario is selected Ÿ Click Next Ÿ Choose Office from the Network Scale list Ÿ Click Next Ÿ Assign 200 to X Span and keep Y Span as 100 Ÿ Click Next twice Ÿ Click OK. 4. Close the Object Palette dialog box.



Create the Network To create our coaxial Ethernet network: 1. To create the network configuration, select Topology Ÿ Rapid Configuration. From the drop-down menu choose Bus and click OK. 2. Click the Select Models button in the Rapid Configuration dialog box. From the Model List drop-down menu choose ethcoax and click OK. 3. In the Rapid Configuration dialog box, set the following eight values and click OK. The eth_tap is an Ethernet bus tap that connects a node with the bus. The eth_coax is an Ethernet bus that can connect nodes with bus receivers and transmitters via taps.
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4. To configure the coaxial bus, right-click on the horizontal link Ÿ Select Advanced Edit Attributes from the menu: a. Click on the value of the model attribute Ÿ Select Edit from the dropdown menu Ÿ Choose the eth_coax_adv model. b. Assign the value 0.05 to the delay attribute (propagation delay in sec/m). c. Assign 5 to the thickness attribute. d. Click OK.



A higher delay is used here as an alternative to generating higher traffic which would require much longer simulation time.



Thickness specifies the thickness of the line used to “draw” the bus link.



5. Now you have created the network. It should look like the illustration below. 6. Make sure to save your project.



8



Network Simulation Experiments Manual



Configure the Network Nodes To configure the traffic generated by the nodes: 1. Right-click on any of the 30 nodes Ÿ Select Similar Nodes. Now all nodes in the network are selected. 2. Right-click on any of the 30 nodes Ÿ Edit Attributes. 3. Check the Apply Changes to Selected Objects check box. This is important to avoid reconfiguring each node individually. 4. Expand the Traffic Generation Parameters hierarchy: The argument of the exponential distribution is the mean of the interval between successive events. In the exponential distribution the probability of occurrence of the next event by a given time is not at all dependent upon the time of occurrence of the last event or the elapsed time since that event.



a. Change the value of the ON State Time to exponential(100) Ÿ Change the value of the OFF State Time to exponential(0). (Note: Packets are generated only in the "ON" state.) 5. Expand the Packet Generation Arguments hierarchy: a. Change the value of the Packet Size attribute to constant(1024). b. Right-click on the Interarrival Time attribute and choose Promote Attribute to Higher Level. This allows us to assign multiple values to the Interarrival Time attribute and hence to test the network performance under different loads.



The interarrival time is the time between successive packet generations in the "ON" state.



6. Click OK to return back to the Project Editor. 7. Make sure to save your project.
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Configure the Simulation To examine the network performance under different loads, you need to run the simulation several times by changing the load into the network. There is an easy way to do that. Recall that we promoted the Interarrival Time attribute for package generation. Here we will assign different values to that attribute: Ÿ Make sure that the 1. Click on the Configure/Run Simulation button: Common tab is chosen Ÿ Assign 15 seconds to the Duration.



2. Click on the Object Attributes tab. 3. Click on the Add button. The Add Attribute dialog box should appear filled with the promoted attributes of all nodes in the network (if you do not see the attributes in the list, close the whole project and reopen it). You need to add the Interarrival Time attribute for all nodes. To do that: a. Click on the first attribute in the list (Office Network.node_0.Traffic Generation ….) Ÿ Click the Wildcard button Ÿ Click on node_0 and choose the asterisk (*) from the dropdown menu Ÿ Click OK. b. A new attribute is now generated containing the asterisk (the second one in the list), and you need to add it by clicking on the corresponding cell under the Add? column. c. The Add Attribute dialog box should look like the shown one Ÿ Click OK.
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4. Now you should see the Office Network.*.Traffic Generation Parameter … in the list of simulation object attributes. Click on that attribute to select it Ÿ Click the Values button of the dialog box. 5. Add the following nine values. (Note: To add the first value, double-click on the first cell in the Value column Ÿ Type “exponential (2)” into the textbox and hit enter. Repeat this for all nine values.)



6. Click OK. Now look at the upper-right corner of the Simulation Configuration dialog box and make sure that the Number of runs in set is 9.



7. For each simulation of the nine runs, we need the simulator to save a “scalar” value that represents the “average” load in the network and to save another scalar value that represents the average throughput of the network. To save
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these scalars we need to configure the simulator to save them in a file. Click on the Advanced tab in the Configure Simulation dialog box. 8. Assign _Ethernet_Coax to the Scalar file text field.



9. Click OK and then save your project.



Choose the Statistics To choose the statistics to be collected during the simulation: 1. Right-click anywhere in the project workspace (but not on one of the nodes or links) and select Choose Individual Statistics from the pop-up menu Ÿ Expand the Global Statistics hierarchy. a. Expand the Traffic Sink hierarchy Ÿ Click the check box next to Traffic Received (packets/sec) (make sure you select the statistic with units of packets/sec), b. Expand the Traffic Source hierarchy Ÿ Click the check box next to Traffic Sent (packets/sec). c.



Click OK.



2. Now to collect the average of the above statistics as a scalar value by the end of each simulation run: A probe represents a request by the user to collect a particular piece of data about a simulation.



a. Select Choose Statistics (Advanced) from the Simulation menu. b. The Traffic Sent and Traffic Received probes should appear under the Global Statistic Probes.
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c.



Right-click on Traffic Received probe Ÿ Edit Attributes. Set the scalar data attribute to enabled Ÿ Set the scalar type attribute to time average Ÿ Compare to the following figure and click OK.



d. Repeat the previous step with the Traffic Sent probe. e. Select save from the File menu in the Probe Model window and then close that window. f.



Now you are back to the Project Editor. Make sure to save your project.



Run the Simulation To run the simulation: Ÿ Make sure that 15 1. Click on the Configure/Run Simulation button: second(s) (not hours) is assigned to the Duration Ÿ Click Run. Depending on the speed of your processor, this may take several minutes to complete. 2. Now the simulator is completing nine runs, one for each traffic generation interarrival time (representing the load into the network). Notice that each successive run takes longer to complete because the traffic intensity is increasing. 3. After the nine simulation runs complete, click Close. 4. Save your project. When you rerun the simulation, OPNET IT Guru will “append” the new results to the results already in the scalar file. To avoid that, delete the scalar file before you start a new run. (Note: Deleting the scalar file after a run will result in losing the collected results from that run.) •



Go to the File menu Ÿ Select Model Files Ÿ Delete Model Files Ÿ Select ( .os): Output Scalars Ÿ Select the scalar file to be deleted; in this lab it
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is _Ethernet_Coax Ÿ Confirm the deletion by clicking OK Ÿ Click Close.



View the Results To view and analyze the results: 1. Select View Results (Advanced) from the Results menu. Now the Analysis Configuration tool is open. 2. Recall that we saved the average results in a scalar file. To load this file, select Load Output Scalar File from the File menu Ÿ Select _Ethernet-Coax from the pop-up menu. 3. Select Create Scalar Panel from the Panels menu Ÿ Assign Traffic Source.Traffic Sent (packets/sec).average to Horizontal Ÿ Assign Traffic Sink.Traffic Received (packets/sec).average to Vertical Ÿ Click OK.



4. The resulting graph should resemble the one below:
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Further Readings −



OPNET Ethernet Model Description: From the Protocols menu, select Ethernet Ÿ Model Usage Guide.



Exercises 1) Explain the graph we received in the simulation that shows the relationship



between the received (throughput) and sent (load) packets. Why does the throughput drop when the load is either very low or very high? 2) Create three duplicates of the simulation scenario implemented in this lab. Name



these scenarios Coax_Q2a, Coax_Q2b, and Coax_Q2c. Set the Interarrival Time attribute of the Packet Generation Arguments for all nodes (make sure to check Apply Changes to Selected Objects while editing the attribute) in the new scenarios as follows: -



Coax_Q2a scenario: exponential(0.1) Coax_Q2b scenario: exponential(0.05) Coax_Q2c scenario: exponential(0.025)



In all the above new scenarios, open the Configure Simulation dialog box and from the Object Attributes delete the multiple-value attribute (the only attribute shown in the list). Choose the following statistic for node 0: Ethcoax →Collision Count. Make sure that the following global statistic is chosen: Global Statistics→Traffic Sink→Traffic Received (packet/sec). (Refer to the Choose the Statistics section in the lab.) Run the simulation for all three new scenarios. Get two graphs: one to compare node 0’s collision counts in these three scenarios and the other graph to compare the received traffic from the three scenarios. Explain the graphs and comment on the results. (Note: To compare results you need to select Compare Results from the Results menu after the simulation run is done.) 3) To study the effect of the number of stations on Ethernet segment performance,



create a duplicate of the Coax_Q2c scenario, which you created in Exercise 2. Name the new scenario Coax_Q3. In the new scenario, remove the oddnumbered nodes, a total of 15 nodes (node 1, node 3, …, and node 29). Run the simulation for the new scenario. Create a graph that compares node 0’s collision counts in scenarios Coax_Q2c and Coax_Q3. Explain the graph and comment on the results.
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4) In the simulation a packet size of 1024 bytes is used (Note: Each Ethernet packet



can contain up to 1500 bytes of data). To study the effect of the packet size on the throughput of the created Ethernet network, create a duplicate of the Coax_Q2c scenario, which you created in Exercise 2. Name the new scenario Coax_Q4. In the new scenario use a packet size of 512 bytes (for all nodes). For both Coax_Q2c and Coax_Q4 scenarios, choose the following global statistic: Global Statistics→Traffic Sink→Traffic Received (bits/sec). Rerun the simulation of Coax_Q2c and Coax_Q4 scenarios. Create a graph that compares the throughput as packets/sec and another graph that compares the throughput as bits/sec in Coax_Q2c and Coax_Q4 scenarios. Explain the graphs and comment on the results.



Lab Report Prepare a report that follows the guidelines explained in Lab 0. The report should include the answers to the above exercises as well as the graphs you generated from the simulation scenarios. Discuss the results you obtained and compare these results with your expectations. Mention any anomalies or unexplained behaviors.



Laboratory
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Token Ring A Shared-Media Network with Media Access Control Objective This lab is designed to demonstrate the implementation of a token ring network. The simulation in this lab will help you examine the performance of the token ring network under different scenarios.



Overview A token ring network consists of a set of nodes connected in a ring. The ring is a single shared medium. The token ring technology involves a distributed algorithm that controls when each node is allowed to transmit. All nodes see all frames. The destination node, which is identified in the frame header, saves a copy of the frame as the frame flows past the node. With a ring topology, any link or node failure would render the whole network useless. This problem can be solved by using a star topology where nodes are connected to a token ring hub. The hub acts as a relay, known as a multistation access unit (MSAU). MSAUs are almost always used because of the need for robustness and ease of node addition and removal. The “token,” which is just a special sequence of bits, circulates around the ring; each node receives and then forwards the token. When a node that has a frame to transmit sees the token, it takes the token off the ring and instead inserts its frame into the ring. When the frame makes its way back around to the sender, this node strips its frame off the ring and reinserts the token. The token holding time (THT) is the time a given node is allowed to hold the token. From its definition, the THT has an effect on the utilization and fairness of the network, where utilization is the measure of the bandwidth used versus that available on the given ring. In this lab, you will set up a token ring network with 14 nodes connected in a star topology. The links you will use operate at a data rate of 4 Mbps. You will study how the utilization and delay of the network are affected by the network load as well as the THT.



Prelab Activities







Read section 2.7 from "Computer Networks: A Systems Approach", 4th Edition.
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Procedure Create a New Project To create a new project for the token ring network: 1. Start OPNET IT Guru Academic Edition Ÿ Choose New from the File menu. 2. Select Project and click OK Ÿ Name the project _Token, and the scenario Balanced Ÿ Click OK. 3. In the Startup Wizard: Initial Topology dialog box, make sure that Create Empty Scenario is selected Ÿ Click Next Ÿ Choose Office for the Network scale Ÿ Click Next three times Ÿ Click OK. 4. Close the Object Palette and then save your project.



Create the Network To create our token ring network: 1. Select Topology Ÿ Rapid Configuration. From the drop-down menu choose Star and click OK. 2. Click the Select Models button in the Rapid Configuration dialog box. From the Model List drop-down menu choose token_ring and click OK. 3. In the Rapid Configuration dialog box, set the following six values and click OK.



The tr32_hub node model is a token ring hub supporting up to 32 connections at 4 or 16 Mbps. The hub forwards an arriving packet to the next output port. There is no queuing of packets in the hub itself as the processing time is considered to be zero.



The TR4 link connects two token ring devices to form a ring at 4 Mbps.
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4. You have now created the network, and it should look like the following:



5. Make sure to save your project.



Configure the Network Nodes Here you will configure the THT of the nodes as well as the traffic generated by them. To configure the THT of the nodes, you need to use the tr_station_adv model for the nodes instead of the current one, tr_station. 1. Right-click on any of the 14 nodes Ÿ Select Similar Nodes. Now all nodes in the network are selected. 2. Right-click on any of the 14 nodes Ÿ Edit Attributes. a. Check the Apply Changes to Selected Objects check box. This is important to avoid reconfiguring each node individually. The following figure shows the attributes we will change in steps 3 to 6:
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The THT (token holding time) specifies the maximum amount of time a token ring MAC (media access control) may use the token before releasing it.



The interarrival time is the time between successive packet generations in the "ON" state.



3. Click on the model value: tr_station and select Edit from the drop-down menu. Now select tr_station_adv from the extended drop-down menu. 4. To test the network under different THT values, you need to “promote” the THT parameter. This allows us to assign multiple values to the THT attribute. a. Expand the Token Ring Parameters hierarchy. b. Right-click on the THT Duration attribute Ÿ Choose Promote Attribute to Higher Level. 5. Expand the Traffic Generation Parameters hierarchy Ÿ Assign exponential(100) to the ON State Time attribute Ÿ Assign exponential(0) to the OFF State Time attribute. (Note: Packets are generated only in the "ON" state.) 6. Expand the Packet Generation Arguments exponential(0.025) to the Interarrival Time attribute. 7. Click OK to return back to the Project Editor. 8. Make sure to save your project.



hierarchy



Ÿ



Assign
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Configure the Simulation To examine the network performance under different THTs, you need to run the simulation several times by changing THT with every run of the simulation. There is an easy way to do that. Recall that we promoted the THT Duration attribute. Here we will assign different values to that attribute: 1. Click on the Configure/Run Simulation button: 2. Make sure that the Common tab is chosen Ÿ Assign 5 minutes to the Duration.



3. Click on the Object Attributes tab Ÿ Click the Add button. 4. As shown in the following Add Attribute dialog box, you need to add the THT Duration attribute for all nodes. To do that: a. Add the unresolved attribute: Office Network.*.Token Ring Parameters[0].THT Duration by clicking on the corresponding cell under the Add? column Ÿ Click OK.



Token Ring



21



5. Now you should see the Office Network.*.Token Ring Parameters[0].THT Duration in the list of simulation object attributes (widen the “Attribute” column to see the full name of the attribute). Click on that attribute Ÿ Click the Values button, as shown below.



6. Add the following six values. (Note: To add the first value, double-click on the first cell in the Value column Ÿ Type “0.01” into the textbox and hit enter. Repeat this for all six values.)
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7. Click OK. Now look at the upper-right corner of the Simulation Configuration dialog box and make sure that the Number of runs in set is 6.



8. For each of the six simulation runs we need the simulator to save “scalar” values that represent the “average” values of the collected statistics. To save these scalars we need to configure the simulator to save them in a file. Click on the Advanced tab in the Configure Simulation dialog box. 9. Assign _Token_Balanced to the Scalar file text field.



10. Click OK and then save your project.
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Choose the Statistics To choose the statistics to be collected during the simulation: 1. Right-click anywhere in the project workspace (but not on a node or link) and select Choose Individual Statistics from the pop-up menu. a. Expand the Global Statistics hierarchy: − − The utilization is a measure of the bandwidth used versus that available on the given ring.



Expand the Traffic Sink hierarchy Ÿ Click the check box next to Traffic Received (packets/sec). Expand the Traffic Source hierarchy Ÿ Click the check box next to Traffic Sent (packets/sec).



b. Expand the Node Statistics hierarchy: − c.



Expand the Token Ring hierarchy Ÿ Click the check box next to Utilization.



Click OK.



2. Now we want to collect the average of the above statistics as a scalar value by the end of each simulation run. a. Select Choose Statistics (Advanced) from the Simulation menu. A probe represents a request by the user to collect a particular piece of data about a simulation.



b. The Traffic Sent and Traffic Received probes should appear under the Global Statistic Probes. The Utilization probe should appear under the Node Statistics Probes. c.



Right-click on Traffic Received probe Ÿ Edit Attributes. Set the scalar data attribute to enabled Ÿ Set the scalar type attribute to time average Ÿ Compare to the following figure and click OK.



d. Repeat the previous step with the Traffic Sent and Utilization probes.
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3. Since we need to analyze the effect of THT on the network performance, THT must be added as an “input” statistic to be recorded by the simulation. To do that: a. Select Create Attribute Probe from the Objects menu. Now a new attribute is created under the Attribute Probes hierarchy as shown. b. Right-click on the new attribute probe and select Choose Attributed Object from the pop-up menu Ÿ Expand the Office Network hierarchy Ÿ Click on node_0 (actually you can pick any other node) Ÿ Click OK.



c.



Right-click again on the new attribute probe and select Edit Attributes from the pop-up menu Ÿ Assign the Token Ring Parameter[0].THT Duration value to the “attribute” Attribute, as shown in the figure Ÿ Click OK.



4. Select save from the File menu in the Probe Model window and then Close the window. 5. Now you are back to the Project Editor. Make sure to save your project.
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Duplicate the Scenario The token ring network scenario we just implemented is balanced: the distribution of the generated traffic in all nodes is the same. To compare performance, you will create an “unbalanced” scenario as follows: 1. Select Duplicate Scenario from the Scenarios menu and give it the name Unbalanced Ÿ Click OK. 2. Select node_0 and node_7 by shift-clicking on both nodes Ÿ Right-click on one of these two selected nodes and select Edit Attributes Ÿ Expand the Traffic Generation Parameters hierarchy Ÿ Expand the Packet Generation Arguments hierarchy Ÿ Change the value of the Interarrival Time attribute to exponential(0.005) as shown. Make sure to check the Apply Changes to Selected Objects box before you click OK.



3. Select all nodes except node_0 and node_7 Ÿ Right-click on one of the selected nodes and select Edit Attributes Ÿ Change the value of the Interarrival Time attribute to exponential(0.075) as in the previous step. Make sure to check the Apply Changes to Selected Objects box before you click OK. 4. Click anywhere in the workspace to unselect objects. 5. Click on the Configure/Run Simulation button: Ÿ Click on the Advanced tab in the Configure Simulation dialog box Ÿ Assign _Token_Unbalanced to the Scalar file text field. 6. Click OK and then save your project.
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Run the Simulation To run the simulation for both scenarios simultaneously: 1. Go to the Scenarios menu Ÿ Select Manage Scenarios. 2. Change the values under the Results column to (or ) for both scenarios. Compare to the following figure.



3. Click OK to run the simulations. Depending on the speed of your processor, this may take several minutes to complete. 4. After the simulation completes the 12 runs, 6 for each scenario, click Close. 5. Save your project. When you rerun the simulation, OPNET IT Guru will “append” the new results to the results already in the scalar file. To avoid that, delete the scalar file before you start a new run. •



Go to the File menu Ÿ Select Model Files Ÿ Delete Model Files Ÿ From the list, choose other model types Ÿ Select ( .os): Output Scalars Ÿ Select the scalar file to be deleted; in this lab they are _Token_Balanced and _Token_Unbalanced Ÿ Click Close.



View the Results To view and analyze the results: 1. Select View Results (Advanced) from the Results menu. Now the Analysis Configuration tool is open. 2. Recall that we saved the average results in two scalar files, one for each scenario. To load the scalar file for the Balanced scenario, select Load Output
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Scalar File from the File menu Ÿ Select _Token_Balanced from the pop-up menu. 3. Select Create Scalar Panel from the Panels menu Ÿ Select the scalar panel data as shown in the following dialog box: THT for Horizontal and Utilization for Vertical. (Note: If any of the data is missing, make sure that you carried out steps 2.c and 2.d in the Choose the Statistics section.)



4. Click OK. 5. To change the title of the graph, right-click on the graph area and choose Edit Graph Properties Ÿ Change the Custom Title to Balanced Utilization as shown.



6. Click OK. The resulting graph should resemble the one shown below. Do not close the graph and continue with the following step.
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7. To compare with the Unbalanced scenario, load its scalar file, select Load Output Scalar File from the File menu Ÿ Select _Token_Unbalanced from the pop-up menu. 8. Select Create Scalar Panel from the Panels menu Ÿ Select the scalar panel data as in step 3. 9. Click OK Ÿ Change the graph title to Unbalanced as in step 5 Ÿ Click OK. The resulting graph should resemble the one shown below. Do not close this graph or the previous one and continue with the following step.
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10. To combine the above two graphs on a single graph, select Create Vector Panel from the Panels menu Ÿ Click on the Display Panel Graphs tab Ÿ Select both Balanced and Unbalanced statistics Ÿ Choose Overlaid Statistics from the drop-down menu in the right-bottom area of the dialog box as shown.



11. Click Show and the resulting graph should resemble the one shown below.
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12. Repeat the same process to check the effect of the THT on Traffic Received for both scenarios. Assign the appropriate titles to the graphs. 13. The resulting graph, which combines the Traffic Received statistic for both the Balanced and Unbalanced scenarios, should resemble the following one:
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Further Readings −



OPNET Token Ring Model Description: From the Protocols menu, select Token Ring Ÿ Model Usage Guide.



Exercises 1) Why does the utilization increase with higher THT values? 2) Create a duplicate scenario of the Balanced scenario. Name the new scenario



Q2_HalfLoad. In the Q2_HalfLoad scenario, decrease the load into the network (i.e., load from all nodes in the network) by half and repeat the simulation. Compare the utilization and traffic received in the Q2_HalfLoad scenario with those of the Balanced scenario. Hints: -



Decreasing the load from a node by half can be done by doubling the “Interarrival Time” of the node’s Packet Generation Arguments. Do not forget to assign a separate “scalar file” for the new scenario.



3) Create a duplicate scenario of the Balanced scenario. Name the new scenario



Q3_OneNode. In the Q3_OneNode scenario, reconfigure the network so that node_0 generates a traffic load that is equivalent to the traffic load generated by all nodes in the Balanced scenario combined. The rest of the nodes, node_1 to node_13, generate no traffic. Compare the utilization and traffic received in Q3_OneNode scenario with those of the Balanced scenario. Hints: -



-



One way to configure a node so that it does not generate traffic is to set its Start Time (it is one of the Traffic Generation Parameters) to the special value Never. Do not forget to assign a separate “scalar file” for the new scenario.



Lab Report Prepare a report that follows the guidelines explained in Lab 0. The report should include the answers to the above exercises as well as the graphs you generated from the simulation scenarios. Discuss the results you obtained and compare these results with your expectations. Mention any anomalies or unexplained behaviors.



Laboratory
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Switched LANs A Set of Local Area Networks Interconnected by Switches Objective This lab is designed to demonstrate the implementation of switched local area networks. The simulation in this lab will help you examine the performance of different implementations of local area networks connected by switches and hubs.



Overview There is a limit to how many hosts can be attached to a single network and to the size of a geographic area that a single network can serve. Computer networks use switches to enable the communication between one host and another, even when no direct connection exists between those hosts. A switch is a device with several inputs and outputs leading to and from the hosts that the switch interconnects. The core job of a switch is to take packets that arrive on an input and forward (or switch) them to the right output so that they will reach their appropriate destination. A key problem that a switch must deal with is the finite bandwidth of its outputs. If packets destined for a certain output arrive at a switch and their arrival rate exceeds the capacity of that output, then we have a problem of contention. In this case, the switch will queue, or buffer, packets until the contention subsides. If the contention lasts too long, however, the switch will run out of buffer space and be forced to discard packets. When packets are discarded too frequently, the switch is said to be congested. In this lab you will set up switched LANs using two different switching devices: hubs and switches. A hub forwards the packet that arrives on any of its inputs on all the outputs regardless of the destination of the packet. On the other hand, a switch forwards incoming packets to one or more outputs depending on the destination(s) of the packets. You will study how the throughput and collision of packets in a switched network are affected by the configuration of the network and the types of switching devices that are used.
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Prelab Activities







Read section 3.1 from "Computer Networks: A Systems Approach", 4th Edition. Go to www.net-seal.net/animations.php and play the following animations: - Switch. - Switched Network With No Server. - Switched Network With Server.



Procedure Create a New Project 1.



Start the OPNET IT Guru Academic Edition Ÿ Choose New from the File menu.



2. Select Project and click OK Ÿ Name the project _SwitchedLAN, and the scenario OnlyHub Ÿ Click OK. 3.



In the Startup Wizard: Initial Topology dialog box, make sure that Create Empty Scenario is selected Ÿ Click Next Ÿ Choose Office from the Network Scale list Ÿ Click Next three times Ÿ Click OK.



4. Close the Object Palette dialog box.



Create the Network To create our switched LAN: 1. Select Topology Ÿ Rapid Configuration. From the drop-down menu choose Star and click OK. 2. Click the Select Models button in the Rapid Configuration dialog box. From the Model List drop-down menu choose ethernet and click OK. The prefix ethernet16_ indicates that the device supports up to 16 Ethernet connections.



3. In the Rapid Configuration dialog box, set the following five values: Center Node Model = ethernet16_hub, Periphery Node Model = ethernet_station, Link Model = 10BaseT, Number=16, Y=50, and Radius = 42 Ÿ Click OK.
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The 10BaseT link represents an Ethernet connection operating at 10 Mbps.



4. Right-click on node_16, which is the hub Ÿ Edit Attributes Ÿ Change the name attribute to Hub1 and click OK. 5. Now that you have created the network, it should look like the following one. 6. Make sure to save your project.



Configure the Network Nodes Here you will configure the traffic generated by the stations. 1. Right-click on any of the 16 stations (node_0 to node_15) Ÿ Select Similar Nodes. Now all stations in the network are selected. 2. Right-click on any of the 16 stations Ÿ Edit Attributes. a. Check the Apply Changes to Selected Objects check box. This is important to avoid reconfiguring each node individually.
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3. Expand the hierarchies of the Traffic Generation Parameters attribute and the Packet Generation Arguments attribute Ÿ Set the following four values: 4. Click OK to close the attribute editing window(s). 5. Save your project.



Choose Statistics To choose the statistics to be collected during the simulation: The Ethernet Delay represents the end to end delay of all packets received by all the stations.



1. Right-click anywhere in the project workspace and select Choose Individual Statistics from the pop-up menu.



Traffic Received (in packets/sec) by the traffic sinks across all nodes.



2. In the Choose Results dialog box, choose the following four statistics:



Traffic Sent (in packets/sec) by the traffic sources across all nodes.



Collision Count is the total number of collisions encountered by the hub during packet transmissions.



3. Click OK.
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Configure the Simulation Here we need to configure the duration of the simulation:



1. Click on the Configure/Run Simulation button: 2. Set the duration to be 2.0 minutes. 3. Click OK.



Duplicate the Scenario The network we just created utilizes only one hub to connect the 16 stations. We need to create another network that utilizes a switch and see how this will affect the performance of the network. To do that we will create a duplicate of the current network: 1. Select Duplicate Scenario from the Scenarios menu and give it the name HubAndSwitch Ÿ Click OK. . Make sure that Ethernet is 2. Open the Object Palette by clicking on selected in the pull-down menu on the object palette. 3. We need to place the shown hub and switch in the new scenario.



4. To add the Hub, click its icon in the object palette Ÿ Move your mouse to the workspace Ÿ Click to drop the hub at a location you select. Right-click to indicate you are done deploying hub objects. 5. Similarly, add the Switch and then close the Object Palette. 6.



Right-click on the new hub Ÿ Edit Attributes Ÿ Change the name attribute to Hub2 and click OK.



7.



Right-click on the switch Ÿ Edit Attributes Ÿ Change the name attribute to Switch and click OK.



8. Reconfigure the network of the HubAndSwitch scenario so that it looks like the following one.
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Hints: a. To remove a link, select it and choose Cut from the Edit menu (or simply hit the Delete key). You can select multiple links and delete all of them at once. b. To add a new link, use the 10BaseT link available in the Object Palette.



9. Save your project.



Run the Simulation To run the simulation for both scenarios simultaneously: 1. Select Manage Scenarios from the Scenarios menu. 2. Change the values under the Results column to (or ) for both scenarios. Compare to the following figure.



3. Click OK to run the two simulations. Depending on the speed of your processor, this may take several minutes to complete.
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4. After the two simulation runs complete, one for each scenario, click Close. 5. Save your project.



View the Results To view and analyze the results: 1. Select Compare Results from the Results menu. time_average is the average value over time of the values generated during the collection window. This average is performed assuming a “sample-and-hold” behavior of the data set (i.e., each value is weighted by the amount of time separating it from the following update and the sum of all the weighted values is divided by the width of the collection window). For example, suppose you have a 1-second bucket in which 10 values have been generated. The first 7 values were generated between 0 and 0.3 seconds, the 8th value at 0.4 seconds, the 9th value at 0.6 seconds , and the 10th at 0.99 seconds. Because the last 3 values have higher durations, they are weighted more heavily in calculating the time average.



2. Change the drop-down menu in the lower-right part of the Compare Results dialog box from As Is to time_average, as shown.



3. Select the Traffic Sent (packets/sec) statistic and click Show. The resulting graph should resemble the one below. As you can see, the traffic sent in both scenarios is almost identical.



Switched LANs
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Select the Traffic Received (packets/sec) statistic and click Show. The resulting graph should resemble the one below. As you see, the traffic received with the second scenario, HubAndSwitch, is higher than that of the OnlyHub scenario.



4. Select the Delay (sec) statistic and click Show. The resulting graph should resemble the one below. (Note: Result may vary slightly due to different node placement.)
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5. Select the Collision Count statistic for Hub1 and click Show. 6. On the resulting graph right-click anywhere on the graph area Ÿ Choose Add Statistic Ÿ Expand the hierarchies as shown below Ÿ Select the Collision Count statistic for Hub2 Ÿ Change As Is to time_average Ÿ Click Add.



7. The resulting graph should resemble the one below.



8. Save your project.
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Further Readings −



OPNET Building Networks: From the Protocols menu, select Methodologies Ÿ Building Network Topologies.



Exercises 1) Explain why adding a switch makes the network perform better in terms of



throughput and delay. 2) We analyzed the collision counts of the hubs. Can you analyze the collision count



of the “Switch”? Explain your answer. 3) Create two new scenarios. The first one is the same as the OnlyHub scenario



but replace the hub with a switch. The second new scenario is the same as the HubAndSwitch scenario but replace both hubs with two switches, remove the old switch, and connect the two switches you just added together with a 10BaseT link. Compare the performance of the four scenarios in terms of delay, throughput, and collision count. Analyze the results. Note: To replace a hub with a switch, right-click on the hub and assign ethernet16_switch to its model attribute.



Lab Report Prepare a report that follows the guidelines explained in Lab 0. The report should include the answers to the above exercises as well as the graphs you generated from the simulation scenarios. Discuss the results you obtained and compare these results with your expectations. Mention any anomalies or unexplained behaviors.



Laboratory
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Network Design Planning a Network with Different Users, Hosts, and Services Objective The objective of this lab is to demonstrate the basics of designing a network, taking into consideration the users, services, and locations of the hosts.



Overview Optimizing the design of a network is a major issue. Simulations are usually used to analyze the conceptual design of the network. The initial conceptual design is usually refined several times until a final decision is made to implement the design. The objective is to have a design that maximizes the network performance, taking into consideration the cost constraints and the required services to be offered to different types of users. After the network has been implemented, network optimization should be performed periodically throughout the lifetime of the network to ensure maximum performance of the network and to monitor the utilization of the network resources. In this lab you will design a network for a company that has four departments: Research, Engineering, E-Commerce, and Sales. You will utilize a LAN model that allows you to simulate multiple clients and servers in one simulation object. This model dramatically reduces both the amount of configuration work you need to perform and the amount of memory needed to execute the simulation. You will be able to define a profile that specifies the pattern of applications employed by the users of each department in the company. By the end of this lab, you will be able to study how different design decisions can affect the performance of the network.



Prelab Activities







Read section 3.2 from "Computer Networks: A Systems Approach", 4th Edition. Go to www.net-seal.net/animations.php and play the following animations: - Adding Switches.
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Procedure Create a New Project 1. Start OPNET IT Guru Academic Edition Ÿ Choose New from the File menu. 2. Select Project and click OK Ÿ Name the project _NetDesign, and the scenario SimpleNetwork Ÿ Click OK. 3. In the Startup Wizard: Initial Topology dialog box, make sure that Create Empty Scenario is selected Ÿ Click Next Ÿ Choose Campus from the Network Scale list Ÿ Click Next Ÿ Choose Miles from the Size drop-down menu and assign 1 for both X Span and Y Span Ÿ Click Next twice Ÿ Click OK.



Create and Configure the Network Initialize the Network: Application Config is used to specify applications that will be used to configure users profiles.



1. The Object Palette dialog box should be now on the top of your project space. If it . Make sure that the internet_toolbox is is not there, open it by clicking selected from the pull-down menu on the object palette. 2. Add to the project workspace the following objects from the palette: Application Config, Profile Config, and a subnet.



Profile Config describes the activity patterns of a user or group of users in terms of the applications used over a period of time. You must define the applications using the Application Config object before using this object.



a. To add an object from a palette, click its icon in the object palette Ÿ Move your mouse to the workspace Ÿ Left-click to place the object. Right-click when finished. The workspace should contain the following three objects:



3. Close the Object Palette dialog box and save your project.
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Configure the Services: 1. Right-click on the Application Config node Ÿ Edit Attributes Ÿ Change the name attribute to Applications Ÿ Change the Application Definitions attribute to Default Ÿ Click OK. 2. Right-click on the Profile Config node Ÿ Edit Attributes Ÿ Change the name attribute to Profiles Ÿ Change the Profile Configuration attribute to Sample Profiles Ÿ Click OK. Sample Profiles provides patterns of applications employed by users such as engineers, researchers, salespeople, and multimedia users.



Configure a Subnet: 1. Right-click on the subnet node Ÿ Edit Attributes Ÿ Change the name attribute to Engineering and click OK. 2. Double-click on the Engineering node. You get an empty workspace, indicating that the subnet contains no objects. 3. Open the object palette



and make sure it is still set to internet_toolbox.



4. Add the following items to the subnet workspace: 10BaseT LAN, ethernet16 Switch, and a 10BaseT link to connect the LAN with the Switch Ÿ Close the palette. 5. Right-click on the 10BaseT LAN node Ÿ Edit Attributes Ÿ Change the name attribute to LAN Ÿ Observe that the Number of Workstations attribute has a value of 10. Click in the Value column for the Application: Supported Profiles attribute, and select Edit. You should get a table in which you should do the following: a. Set the number of rows to 1. b. Set the Profile Name to Engineer. Note: Engineer is one of the “sample” profiles provided within the Profile Config object. c. Click OK twice. The object we just created is equivalent to a 10-workstation star topology LAN. The traffic generated from the users of this LAN resembles that generated by “engineers.” 6. Rename the ethernet16 Switch to Switch. 7. The subnet should look like the shown one. 8. Save your project.
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Configure All Departments: 1. Now you have completed the configuration of the Engineering department subnet. To go back to the main project space, click the Go to the higher level button. The subnets of the other departments in the company should be similar to the engineering one except for the supported profiles. 2. Make three copies of the Engineering subnet we just created: Click on the Engineering node Ÿ From the Edit menu, select Copy Ÿ From the Edit menu, select Paste three times, placing the subnet in the workspace after each, to create the new subnets. 3. Rename (right-click on the subnet and select Set Name) and arrange the subnets as shown below:



4. Double-click the Research node Ÿ Edit the attributes of its LAN Ÿ Edit the value of the Application: Supported Profiles attribute Ÿ Change the value of the Profile Name from Engineer to Researcher Ÿ Click OK twice Ÿ Go to the higher level by clicking the



button.



5. Repeat step 4 with the Sales node and assign to its Profile Name the profile Sales Person. 6. Repeat step 4 with the E-Commerce node and assign to its Profile Name the profile E-commerce Customer. 7. Save your project.
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Configure the Servers: Now we need to implement a subnet that contains the servers. The servers have to support the applications defined in the profiles we deployed. You can double-check those applications by editing the attributes of our Profile node. Inspect each row under the Applications hierarchy, which in turn, is under the Profile Configuration hierarchy. You will see that we need servers that support the following applications: Web browsing, Email, Telnet, File Transfer, Database, and File Print. and add a new subnet Ÿ Rename the new 1. Open the Object Palette subnet to Servers Ÿ Double-click the Servers node to enter its workspace. 2. From the Object Palette, add three ethernet_servers, one ethernet16_switch, and three 10BaseT links to connect the servers with the switch. 3. Close the Object Palette. 4. Rename the servers and the switch as follows:



5. Right-click on each one of the above servers and Edit the value of the Application: Supported Services attribute. i. For the Web Server add four rows to support the following services: Web Browsing (Light HTTP1.1), Web Browsing (Heavy HTTP1.1), Email (Light), and Telnet Session (Light). ii. For the File Server add two rows to support the following services: File Transfer (Light) and File Print (Light). iii. For the Database Server add one row to support the following service: Database Access (Light). 6. Go back to the project space by clicking the Go to the higher level 7. Save your project.



button.
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Connect the Subnets: Now all subnets are ready to be connected together. 1. Open the Object Palette and add four 100BaseT links to connect the subnets of the departments to the Servers subnet. As you create each link, make sure that it is configured to connect the “switches” in both subnets to each other. Do this by choosing them from the drop-down menus as follows:



2. Close the Object Palette. 3. Now your network should resemble the following one:



4. Save your project.
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Choose the Statistics To test the performance of our network we will collect one of the many available statistics as follows: 1. Right-click anywhere in the project workspace and select Choose Individual Statistics from the pop-up menu. 2. In the Choose Results dialog box, choose the following statistic:



Page Response Time is the required time to retrieve the entire page.



3. Click OK.



Configure the Simulation Here we need to configure the duration of the simulation:



1. Click on the Configure/Run Simulation 2. Set the duration to be 30.0 minutes. 3. Press OK.



button.
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Duplicate the Scenario In the network we just created we assumed that there is no background traffic already in the links. In real networks, the links usually have some existing background traffic. We will create a duplicate of the SimpleNetwork scenario but with background utilization in the 100BaseT links. Link utilization is the percentage of the used link bandwidth.



1. Select Duplicate Scenario from the Scenarios menu and give it the name BusyNetwork Ÿ Click OK. 2. Select all the 100BaseT links simultaneously (click on all of them while holding the Shift key) Ÿ Right-click on anyone of them Ÿ Edit Attributes Ÿ Check the Apply Changes to Selected Objects check box. 3. Expand the hierarchy of the Background Utilization attribute Ÿ Expand the row 0 hierarchy Ÿ Assign 99 to the background utilization (%) as shown below.



4. Click OK. 5. Save your project.
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Run the Simulation To run the simulation for both scenarios simultaneously: 1. Go to the Scenarios menu Ÿ Select Manage Scenarios. 2. Change the values under the Results column to (or ) for both scenarios. Compare to the following figure.



3. Click OK to run the two simulations. Depending on the speed of your processor, this may take several seconds to complete. 4. After the two simulation runs complete (one for each scenario), click Close. 5. Save your project.
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View the Results To view and analyze the results: 1. Select Compare Results from the Results menu. 2. Change the drop-down menu in the lower-right part of the Compare Results dialog box from As Is to time_average as shown.



3. Select the Page Response Time (seconds) statistic and click Show. The resulting graph should resemble the one below. (Note: Results may vary slightly due to different node placement.)
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Further Readings −



OPNET Configuring Applications and Profiles: From the Protocols menu, select Applications Ÿ Model Usage Guide Ÿ Configuring Profiles and Applications.



Exercises 1) Analyze the result we obtained regarding the HTTP page response time. Collect



four other statistics, of your choice, and rerun the simulation of the Simple and the Busy network scenarios. Get the graphs that compare the collected statistics. Comment on these results. 2) In the BusyNetwork scenario, study the utilization% of the CPUs in the servers



(Right-click on each server and select Choose Individual Statistics Ÿ CPU Ÿ Utilization). 3) Create a new scenario as a duplicate of the BusyNetwork scenario. Name the



new scenario Q3_OneServer. Replace the three servers with only one server that supports all required services. Study the utilization% of that server’s CPU. Compare this utilization with the three CPU utilizations you obtained in the previous exercise. 4) Create a new scenario as a duplicate of the BusyNetwork scenario. Name the



new scenario Q4_FasterNetwork. In the Q4_FasterNetwork scenario, replace all 100BaseT links in the network with 10Gbps Ethernet links and replace all 10BaseT links with 100BaseT links. Study how increasing the bandwidth of the links affects the performance of the network in the new scenario (e.g., compare the HTTP page response time in the new scenario with that of the BusyNetwork).



Lab Report Prepare a report that follows the guidelines explained in Lab 0. The report should include the answers to the above exercises as well as the graphs you generated from the simulation scenarios. Discuss the results you obtained and compare these results with your expectations. Mention any anomalies or unexplained behaviors.



Laboratory
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ATM A Connection-Oriented, Cell-Switching Technology Objective The objective of this lab is to examine the effect of ATM adaptation layers and service classes on the performance of the network.



Overview Asynchronous Transfer Mode (ATM) is a connection-oriented, packet-switched technology. The packets that are switched in an ATM network are of a fixed length, 53 bytes, and are called cells. The cell size has a particular effect on carrying voice traffic effectively. The ATM Adaptation Layer (AAL) sits between ATM and the variable-length packet protocols that might use ATM, such as IP. The AAL header contains the information needed by the destination to reassemble the individual cells back into the original message. Because ATM was designed to support all sorts of services, including voice, video, and data, it was felt that different services would have different AAL needs. AAL1 and AAL2 were designed to support applications, like voice, that require guaranteed bit rates. AAL3/4 and AAL5 provide support for packet data running over ATM. ATM provides QoS capabilities through its five service classes: CBR, VBR-rt, VBR-nrt, ABR, and UBR. With CBR (constant bit rate), sources transmit stream traffic at a fixed rate. CBR is well-suited for voice traffic that usually requires circuit switching. Therefore, CBR is very important to telephone companies. UBR, unspecified bit rate, is ATM’s besteffort service. There is one small difference between UBR and the best-effort model. Because ATM always requires a signaling phase before data is sent, UBR allows the source to specify a maximum rate at which it will send. Switches may make use of this information to decide whether to admit or reject the new VC (virtual circuit). In this lab you will set up an ATM network that carries three applications: Voice, Email, and FTP. You will study how the choice of the adaptation layer as well as the service classes can affect the performance of the applications.



Prelab Activities







Read section 3.3 from "Computer Networks: A Systems Approach", 4th Edition.
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Procedure Create a New Project 1. Start OPNET IT Guru Academic Edition Ÿ Choose New from the File menu. 2. Select Project and click OK Ÿ Name the project _ATM, and the scenario CBR_UBR Ÿ Click OK. 3. In the Startup Wizard: Initial Topology dialog box, make sure that Create Empty Scenario is selected Ÿ Click Next Ÿ Select Choose From Maps from the Network Scale list Ÿ Click Next Ÿ Choose USA from the maps Ÿ Click Next Ÿ From the Select Technologies list, include the atm_advanced Model Family as shown in the following figureŸ Click Next Ÿ Click OK.



Create and Configure the Network Initialize the Network: 1. The Object Palette dialog box should now be on the top of your project . Make sure that workspace. If it is not there, open it by clicking atm_advanced is selected from the pull-down menu on the object palette. 2. Add to the project work space the following objects from the palette: Application Config, Profile Config, two atm8_crossconn_adv switches, and a subnet. a. To add an object from a palette, click its icon in the object palette Ÿ Move your mouse to the workspace and click to place the object Ÿ Right-click to get out of “object creation mode.” 3. Close the Object Palette dialog box and rename (right-click on the node Ÿ Set Name) the objects you added as shown and then save your project:
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Configure the Applications: 1. Right-click on the Applications node Ÿ Edit Attributes Ÿ Expand the Application Definitions attribute and set rows to 3 Ÿ Name the rows: FTP, EMAIL, and VOICE.



PCM stands for Pulse Code Modulation. It is a procedure used to digitize speech before transmitting it over the network.



i. Go to the FTP row Ÿ Expand the Description hierarchy Ÿ Assign High Load to FTP. ii. Go to the EMAIL row Ÿ Expand the Description hierarchy Ÿ Assign High Load to Email. iii. Go to the VOICE row Ÿ Expand the Description hierarchy Ÿ Assign PCM Quality Speech to Voice.



2. Click OK and then save your project.
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Configure the Profiles: 1. Right-click on the Profiles node Ÿ Edit Attributes Ÿ Expand the Profile Configuration attribute and set rows to 3. i. Name and set the attributes of row 0 as shown:



ii. Name and set the attributes of row 1 as shown:
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iii. Name and set the attributes of row 2 as shown. (Note: To set the Duration to exponential(60), you will need to assign “Not Used” to the “Special Value”) Ÿ Close the Object Palette dialog box.



Configure the NorthEast Subnet: 1. Double-click on the NorthEast subnet node. You get an empty workspace, indicating that the subnet contains no objects. and make sure that atm_advanced is selected from 2. Open the object palette the pull-down menu on the object palette.. 3. Add the following items to the subnet workspace: one atm8_crossconn_adv switch, one atm_uni_server_adv, four atm_uni_client_adv, and connect them with bidirectional atm_adv links Ÿ Close the palette Ÿ Rename the objects as shown.
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4. Change the data rate attribute for all links to DS1. Hint: To edit the attributes of multiple nodes in a single operation, select all nodes simultaneously using shift and left-click; then Edit Attributes of one of the nodes, and select Apply Changes to Selected Objects.



5. For both NE_Voice1 and NE_Voice2, set the following attributes: i. Set ATM Application Parameters to CBR only. ii. Expand the ATM Parameters hierarchy Ÿ Set Queue Configuration to CBR only. iii. Expand the Application: Supported Profiles hierarchy Ÿ Set rows to 1 Ÿ Expand the row 0 hierarchy Ÿ Set Profile Name to VOICE_P. iv. Application: Supported Services Ÿ Edit its value Ÿ Set rows to 1 Ÿ Set Name of the added row to VOICE Ÿ Click OK. v. Expand the Application: Transport Protocol hierarchy Ÿ Voice Transport = AAL2.



Client Address is the Transport Adaptation Layer (TPAL) address of the node. This value must be unique for each node. The TPAL model suite presents a basic, uniform interface between applications and transport layer models. All interactions with a remote application through TPAL are organized into sessions. A session is a single conversation between two applications through a transport protocol.



6. For NE_Voice1, select Edit Attributes Ÿ Edit the value of the Client Address attribute and write down NE_Voice1. 7. For NE_Voice2, select Edit Attributes Ÿ Edit the value of the Client Address attribute and write down NE_Voice2. 8. Configure the NE_DataServer as follows: i. Application: Supported Services Ÿ Edit its value Ÿ Set rows to 2 Ÿ Set Name of the added rows to: EMAIL and FTP Ÿ Click OK. ii. Expand the Application: Transport Protocol Specification hierarchy Ÿ Voice Transport = AAL2. iii. Edit the value of the Server Address attribute and write down NE_DataServer. 9. For both NE_Data1 and NE_Data2, set the following attributes:



The queue configuration specifies a one-to-one mapping between output port queues and the QoS that they support. A specific queue may be configured to support a specific QoS.



i. Expand the ATM Parameters hierarchy Ÿ Set Queue Configuration to UBR. ii. Expand the Application: Supported Profiles hierarchy Ÿ Set rows to 2 Ÿ Set Profile Name to FTP_P (for row 0) and to EMAIL_P (for row 1). 10. For NE_Data1, select Edit Attributes Ÿ Edit the value of the Client Address attribute and write down NE_Data1. 11. For NE_Data2, select Edit Attributes Ÿ Edit the value of the Client Address attribute and write down NE_Data2. 12. Save your project.
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Add Remaining Subnets: 1. Now you completed the configuration of the NorthEast subnet. To go back to the project space, click the Go to the higher level



button.



The subnets of the other regions should be similar to the NorthEast one except for the names and client addresses. 2. Make three copies of the subnet we just created. 3. Rename (right-click on the node Ÿ Set Name) the subnets and connect them to the switches with bidirectional atm_adv links as shown. (Note: You will be asked to pick the node inside the subnet to be connected to the link. Make sure to choose the “switch” inside each subnet to be connected.)



4. Change the data rate for all links to DS1. 5. Select and double-click each of the new subnets (total four subnets) and change the names, client address, and server address of the nodes inside these subnets as appropriate (e.g., replace NE with SW for the SouthWest subnet).
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Hint: To do step 6, you can right-click on any voice station and choose Edit Similar Nodes. This brings up a table in which each node occupies one row and attributes are shown in the columns. Follow the same procedure with similar steps in this lab.
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6. For all voice stations in all subnets (total of eight stations), edit the value of the Application: Destination Preferences attribute as follows: i. Set rows to 1 Ÿ Set Symbolic Name to Voice Destination Ÿ Click on (…) under the Actual Name column Ÿ Set rows to 6 Ÿ For each row choose a voice station that is not in the current subnet. The following figure shows the actual names for one of the voice stations in the NorthEast subnet:



7. For all data stations in all subnets (total of eight stations), configure the Application: Destination Preferences attribute as follows: i. Set rows to 2 Ÿ Set Symbolic Name to FTP Server for the one row and Email Server for the other row Ÿ For each symbolic name (i.e., FTP Server and Email Server), click on (…) under the Actual Name column Ÿ Set rows to 3 Ÿ For each row choose a data server that is not in the current subnet. The following figure shows the actual names for one of the data stations in the NorthEast subnet:
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ATM Hint: To do step 8 in a single operation, you can use the right-click menu on any switch to Select Similar Nodes; then Edit Attributes, and check Apply Changes to Selected Objects. This feature does work, even across objects in different subnets.



8. For all switches in the network (total of six switches), configure the Max_Avail_BW of the CBR queue to be 100%, as shown below, and the Min_Guaran_BW to be 20%.



Max_Avail_BW is the maximum bandwidth allocated to this queue. Calls will be admitted into this queue only if they are within the maximum available bandwidth requirement.



9. Save your project.
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Choose the Statistics To test the performance of the applications defined in the network, we will collect some of the available statistics as follows: 1. Right-click anywhere in the project workspace and select Choose Individual Statistics from the pop-up menu. 2. In the Choose Results dialog box, choose the following statistics:



3. Click OK.
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Configure the Simulation Here we need to configure the duration of the simulation:



1. Click on the Configure/Run Simulation button:



.



2. Set the duration to be 10.0 minutes. 3. Click OK. We will be running the simulation later.



Duplicate the Scenario In the network we just created, we used the CBR service class for the Voice application and the UBR service class for the FTP and Email applications. To analyze the effect of such different classes of services, we will create another scenario that is similar to the CBR_UBR scenario we just created but it uses only one class of service, UBR, for all applications. In addition, to test the effect of the ATM adaptation layer, in the new scenario we will use AAL5 for the Voice application rather than AAL2. 1. Select Duplicate Scenario from the Scenarios menu and give it the name UBR_UBR Ÿ Click OK. 2. For all voice stations in all subnets, reconfigure them as follows. (Check the note below for a faster way to carry out this step.) i. Set ATM Application Parameters to UBR only. ii. ATM Parameters Ÿ Set Queue Configuration to UBR. iii. Application: Transport Protocol Ÿ Set Voice Transport to AAL5. 3. Save your project. Note: One easy way to carry out step 2 above is through the network browser as follows: -



Select Show Network Browser from the View menu.



-



Select Nodes from the drop-down menu, and check the Only Selected check box as shown in the following figure.



-



Write voice in the find field and click Enter.



-



In the network browser you should see a list of all voice stations selected.



-



Right-click on any of the voice stations in the list, select Edit Attributes, and check Apply Changes to Selected Objects.



-



Carry out the configuration changes in step 2 above.



-



To hide the network browser, deselect Show Network Browser from the View menu.
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Run the Simulation To run the simulation for both scenarios simultaneously: 1. Go to the Scenarios menu Ÿ Select Manage Scenarios. 2. Change the values under the Results column to (or ) for both scenarios. Compare to the following figure.



3. Click OK to run the two simulations. Depending on the speed of your processor, this may take several minutes to complete. 4. After the two simulation runs complete, one for each scenario, click Close. 5. Save your project.
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View the Results To view and analyze the results: 1. Select Compare Results from the Results menu. 2. Change the drop-down menu in the right-lower part of the Compare Results dialog box from As Is to time_average as shown.



3. Select the voice Packet Delay Variation statistic and click Show. The resulting graph should resemble the one below. (Note: Result may vary slightly due to different node placement.)
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Further Readings −



OPNET ATM Model Description: From the Protocols menu, select ATM Ÿ Model Usage Guide.



Exercises 1) Analyze the result we obtained regarding the voice Packet Delay Variation time.



Obtain the graphs that compare the Voice packet end-to-end delay, the Email download response time, and the FTP download response time for both scenarios. Comment on the results. 2) Create another scenario as a duplicate of the CBR_UBR scenario. Name the



new scenario Q2_CBR_ABR. In the new scenario you should use the ABR class of service for data, i.e., the FTP and Email applications in the data stations. Compare the performance of the CBR_ABR scenario with that of the CBR_UBR scenario. Hints: - To set ABR class of service to a node, assign ABR Only to its ATM Application Parameters attribute and ABR only (Per VC Queue) to its Queue Configuration (one of the ATM Parameters). - For all switches in the network (total of 6 switches), configure the Max_Avail_BW of the ABR queue to be 100% and the Min_Guaran_BW to be 20%. 3) Edit the FTP application defined in the Applications node so that its File Size is



twice the current size (i.e., make it 100000 bytes instead of 50000 bytes). Edit the EMAIL application defined in the Applications node so that its File Size is five times the current size (i.e., make it 10000 bytes instead of 2000 bytes). Study how this affects the voice application performance in both the CBR_UBR and UBR_UBR scenarios. (Hint: to answer this exercise, you might need to create duplicates of the CBR_UBR and UBR_UBR scenarios. Name the new scenarios Q3_CBR_UBR and Q3_UBR_UBR respectively)



Lab Report Prepare a report that follows the guidelines explained in Lab 0. The report should include the answers to the above exercises as well as the graphs you generated from the simulation scenarios. Discuss the results you obtained and compare these results with your expectations. Mention any anomalies or unexplained behaviors.



Laboratory
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RIP: Routing Information Protocol A Routing Protocol Based on the Distance-Vector Algorithm Objective The objective of this lab is to configure and analyze the performance of the Routing Information Protocol (RIP) model.



Overview A router in the network needs to be able to look at a packet’s destination address and then determines which one of the output ports is the best choice to get the packet to that address. The router makes this decision by consulting a forwarding table. The fundamental problem of routing is: How do routers acquire the information in their forwarding tables? Routing algorithms are required to build the routing tables and hence forwarding tables. The basic problem of routing is to find the lowest-cost path between any two nodes, where the cost of a path equals the sum of the costs of all the edges that make up the path. Routing is achieved in most practical networks by running routing protocols among the nodes. The protocols provide a distributed, dynamic way to solve the problem of finding the lowest-cost path in the presence of link and node failures and changing edge costs. One of the main classes of routing algorithms is the distance-vector algorithm. Each node constructs a vector containing the distances (costs) to all other nodes and distributes that vector to its immediate neighbors. RIP is the canonical example of a routing protocol built on the distance-vector algorithm. Routers running RIP send their advertisements regularly (e.g., every 30 seconds). A router also sends an update message whenever a triggered update from another router causes it to change its routing table. The Internet Control Message Protocol (ICMP) can be utilized to analyze the performance of the created routes. It can be used to model traffic between routers without the need of running applications in an end node. In this lab you will set up a network that utilizes RIP as its routing protocol. You will analyze the routing tables generated in the routers, and you will observe how RIP is affected by link failures. You will also utilize the ICMP to create echo reply messages (i.e., ping) to analyze the created routes.
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Prelab Activities







Read sections 4.1.5, 4.1.7, and 4.2.2 from "Computer Networks: A Systems Approach", 4th Edition. Go to www.net-seal.net/animations.php and play the following animations: - The Address Resolution Protocol (ARP). - ARP with Multiple Networks. - Routing.



Procedure Create a New Project 1. Start OPNET IT Guru Academic Edition Ÿ Choose New from the File menu. 2. Select Project and click OK Ÿ Name the project _RIP, and the scenario NO_Failure Ÿ Click OK. 3. In the Startup Wizard: Initial Topology dialog box, make sure that Create Empty Scenario is selected Ÿ Click Next Ÿ Select Campus from the Network Scale list Ÿ Click Next three times Ÿ Click OK.



Create and Configure the Network Initialize the Network: 1. The Object Palette dialog box should now be on top of your project workspace. If The ethernet4_slip8_ gtwy node model represents an IP-based gateway supporting four Ethernet hub interfaces and eight serial line interfaces. IP packets arriving on any interface are routed to the appropriate output interface based on their destination IP address. The Routing Information Protocol (RIP) or the Open Shortest Path First (OSPF) protocol may be used to dynamically and automatically create the gateway's routing tables and select routes in an adaptive manner.



. Make sure that the internet_toolbox is it is not there, open it by clicking selected from the pull-down menu on the object palette. 2. Add to the project workspace the following objects from the palette: one ethernet4_slip8_gtwy router and two 100BaseT_LAN objects. a. To add an object from a palette, click its icon in the object palette Ÿ Move your mouse to the workspace Ÿ Click to place the object Ÿ Right-click to stop creating objects of that type. 3. Use bidirectional 100BaseT links to connect the objects you just added as in the following figure. Also, rename the objects as shown (right-click on the node Ÿ Set Name). 4. Close the Object Palette dialog box. 5. Save your project.



RIP: Routing Information Protocol
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Configure the Router: 1. Right-click on Router1 Ÿ Edit Attributes Ÿ Expand the IP Routing Parameters hierarchy and set the following: i. Routing Table Export = Once at End of Simulation. This asks the router to export its routing table at the end of the simulation to the simulation log. 2. Click OK and then save your project.



Add the Remaining LANs: 1. Highlight or select simultaneously (using shift and left-click) all five objects that you currently have in the project workspace (one router, two LANs, and two links). You can click-and-drag a box around the objects to do this. 2. Press Ctrl+C to copy the selected objects and then press Ctrl+V to paste them.



The PPP_DS3 link has a data rate of 44.736 Mbps.



3. Repeat step 2 three times to generate three new copies of the objects and arrange them in a way similar to the following figure. Rename all objects as shown. 4. Connect routers, as shown, using PPP_DS3 links.
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Choose the Statistics RIP traffic is the total amount of RIP update traffic (in bits) sent/received per second by all the nodes using RIP as the routing protocol in the IP interfaces in the node. Total Number of Updates is the number of times the routing table at this node gets updated (e.g., due to a new route addition, an existing route deletion, and/or a next hop update).



To test the performance of the RIP protocol, we will collect the following statistics: 1. Right-click anywhere in the project workspace and select Choose Individual Statistics from the pop-up menu. 2. In the Choose Results dialog box, check the following statistics: a. Global Statistics Ÿ RIP Ÿ Traffic Sent (bits/sec). b. Global Statistics Ÿ RIP Ÿ Traffic Received (bits/sec). c. Nodes Statistics Ÿ Route Table Ÿ Total Number of Updates. 3. Click OK and then save your project.



Configure the Simulation Here we need to configure some of the simulation parameters: 1.



Click on



and the Configure Simulation window should appear.



2. Set the duration to be 10.0 minutes. Auto Addressed means that all IP interfaces are assigned IP addresses automatically during simulation. The class of address (e.g., A, B, or C) is determined based on the number of hosts in the designed network. Subnet masks assigned to these interfaces are the default subnet masks for that class. Export causes the autoassigned IP interface to be exported to a file (name of the file is ip_addresses.gdf and gets saved in the primary model directory).



3. Click on the Global Attributes tab and change the following attributes: a. IP Dynamic Routing Protocol = RIP. This sets the RIP protocol to be the routing protocol of all routers in the network. b. IP Interface Addressing Mode = Auto Addressed/Export. c. RIP Sim Efficiency = Disabled. If this attribute is enabled, RIP will stop after the "RIP Stop Time." But we need the RIP to keep updating the routing table in case there is any change in the network (as we will see in the second scenario). 4. Click OK and then save the project.



RIP: Routing Information Protocol
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The Ping Scenario In this scenario we will utilize the ping model to print the list of traversed nodes while the ICMP request message is sent to the destination and the ICMP response is received from the destination. Traversed routes are logged in the simulation log file.. 1. Select Duplicate Scenario from the Scenarios menu and name it ICMP_Ping Ÿ Click OK. 2. Select both Router1 and Router3 simultaneously (click on both of them while holding the Shift key) Ÿ Select the Protocols menu Ÿ IP Ÿ Demands Ÿ Configure Ping Traffic on Selected Nodes. 3. Change the Pattern attribute to Record Route as shown Ÿ Click OK.



Notice that a Ping Parameter node will be added to the project space. In addition the ping demand is created between Rotuer1 and Router3 as a dotted line.



The Failure Scenario The routers in the network we created will build their routing tables with no need to update these tables further because we didn’t simulate any node or link failures. In this scenario we will simulate failures so that we can compare the behavior of the routers in both cases. 1. Select Duplicate Scenario from the Scenarios menu and name it Failure Ÿ Click OK. . Select the Utilities palette from the drop2. Open Object Palette by clicking down menu Ÿ Add a Failure Recovery object to your workspace and name it Failure as shown Ÿ Close the Object Palette dialog box.



72



Network Simulation Experiments Manual



3. Right-click on the Failure object Ÿ Edit Attributes Ÿ Expand the Link Failure/Recovery Specification hierarchy Ÿ Set rows to 1 Ÿ Set the attributes of the added row, row 0, as follows:



This will “fail” the link between Router1 and Router2 200 seconds into the simulation. 5. Click OK and then save the project.



RIP: Routing Information Protocol
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Run the Simulation To run the simulation for both scenarios simultaneously: 1. Go to the Scenarios menu Ÿ Select Manage Scenarios. 2. Change the values under the Results column to (or ) for the three scenarios. Compare to the following figure.



3. Click OK to run the three simulations. Depending on the speed of your processor, this may take several seconds to complete. 4. After the three simulation runs complete, one for each scenario, click Close Ÿ Save your project.



View the Results Compare the Number of Updates: 1. Select Compare Results from the Results menu. 2. Change the drop-down menu in the right-lower part of the Compare Results dialog box to Stacked Statistics and Select Scenarios as shown.
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3. Select the Total Number of Updates statistic for Router1 and click Show Ÿ Select the NO_Failure and Failure scenarios in the Select Scenarios dialog box. 4. You should get two graphs, one for each scenario. Right-click on each graph and select Draw Style Ÿ Bar. 5. The resulting graphs should resemble the following (you can zoom in on the graphs by clicking-anddragging a box over the region of interest):



RIP: Routing Information Protocol
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Obtain the IP Addresses of the Interface: Before checking the contents of the routing tables, we need to determine the IP address information for all interfaces in the current network. Recall that these IP addresses are assigned automatically during simulation, and we set the global attribute IP Interface Addressing Mode to export this information to a file. 1. From the File menu choose Model Files Ÿ Refresh Model Directories. This causes OPNET IT Guru to search the model directories and update its list of files. 2. From the File menu choose Open Ÿ From the drop-down menu choose Generic Data File Ÿ Select the _RIP-NO_Failure-ip_addresses file (the other file created from the Failure scenario should contain the same information) Ÿ Click OK.



3. The following is a part of the gdf file content. It shows the IP addresses assigned to the interfaces of Router1 in our network. For example the interface of Router1 that is connected to Net11 has the IP address 192.0.0.1 (Note: Your result may vary due to different nodes placement.) The Subnet Mask associated with that interface indicates that the address of the subnetwork, to which the interface is connected, is 192.0.0.0 (i.e., the logical AND of the interface IP address and the subnet mask).



4. Print out the layout of the network you implemented in this lab. On this layout, from the information included in the gdf file, write down the IP addresses associated with Router1 as well as the addresses assigned to each subnetwork as shown in the following two figures (Note: Your IP addresses may vary due to different nodes placement.)
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Getting the Ping Report: 1. To check the content of the ping report for Router1: i. Go to the ICMP_Ping scenario Ÿ Go to the Results menu Ÿ Open Simulation Log Ÿ Click on the field PING REPORT for “Campus Network Router1”. The report should resemble the following one:



RIP: Routing Information Protocol
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Compare the Routing Tables Content: 1. To check the content of the routing tables in Router1 for the Failure and NO_Failure scenarios: i. Go to the Results menu Ÿ Open Simulation Log Ÿ Expand the hierarchy on the left as shown below Ÿ Click on the field COMMON ROUTE TABLE.



2. Carry out the previous step for the Failure and NO_Failure scenarios. The following are partial contents of Router1’s routing table for both scenarios (Note: Your results may vary due to different nodes placement):



Routing table of Router1 (NO_Failure scenario):



Loopback interface allows a client and a server on the same host to communicate with each other using TCP/IP.
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Routing table of Router1 (Failure scenario):



RIP: Routing Information Protocol
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Further Readings −



RIP: IETF RFC number 2453 (www.ietf.org/rfc.html).



−



ICMP: IETF RFC number 792 (www.ietf.org/rfc.html).



Exercises 1) Obtain and analyze the graphs that compare the sent RIP traffic for the Failure



and NO_Failure scenarios. Make sure to change the draw style for the graphs to Bar. 2) Describe and explain the effect of the failure of the link connecting Router1 to



Router2 on the routing tables of Router1. 3) Create another scenario as a duplicate of the Failure scenario. Name the new



scenario Q3_Recover. In this new scenario have the link connecting Router1 to Router2 recover after 400 seconds (make sure to keep the failure that occurs at the 200th second). Generate and analyze the graph that shows the effect of this recovery on the Total Number of Updates in the routing table of Router1. Check the contents of Router1‘s routing table. Compare this table with the corresponding routing tables generated in the NO_Failure and Failure scenarios. 4) Change the Ping packet size to 5000 bytes (Hint: Edit the attributes of the Ping



Parameters node). Run the simulation to generate a new Ping report. What is the effect of the new size on the ICMP packet response time?



Lab Report Prepare a report that follows the guidelines explained in Lab 0. The report should include the answers to the above exercises as well as the graphs you generated from the simulation scenarios. Discuss the results you obtained and compare these results with your expectations. Mention any anomalies or unexplained behaviors.



Laboratory
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OSPF: Open Shortest Path First A Routing Protocol Based on the Link-State Algorithm Objective The objective of this lab is to configure and analyze the performance of the Open Shortest Path First (OSPF) routing protocol.



Overview In Lab 6 we discussed RIP, which is the canonical example of a routing protocol built on the distance-vector algorithm. Each node constructs a vector containing the distances (costs) to all other nodes and distributes that vector to its immediate neighbors. Link-state routing is the second major class of intra-domain routing protocol. The basic idea behind link-state protocols is very simple: Every node knows how to reach its directly connected neighbors, and if we make sure that the totality of this knowledge is disseminated to every node, then every node will have enough knowledge of the network to build a complete map of the network. Once a given node has a complete map for the topology of the network, it is able to decide the best route to each destination. Calculating those routes is based on a well-known algorithm from graph theory—Dijkstra’s shortest-path algorithm. OSPF introduces another layer of hierarchy into routing by allowing a domain to be partitioned into areas. This means that a router within a domain does not necessarily need to know how to reach every network within that domain—it may be sufficient for it to know how to get to the right area. Thus, there is a reduction in the amount of information that must be transmitted to and stored in each node. In addition, OSPF allows multiple routes to the same destination to be assigned the same cost and will cause traffic to be distributed evenly over those routers. In this lab, you will set up a network that utilizes OSPF as its routing protocol. You will analyze the routing tables generated in the routers and will observe how the resulting routes are affected by assigning areas and enabling load balancing.
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Prelab Activities







Read sections 4.2.3 and 4.2.4 from "Computer Networks: A Systems Approach", 4th Edition. Go to www.net-seal.net/animations.php and play the following animation: - Routing.



Procedure Create a New Project 1. Start OPNET IT Guru Academic Edition Ÿ Choose New from the File menu. 2. Select Project and click OK Ÿ Name the project _OSPF, and the scenario No_Areas Ÿ Click OK. 3. In the Startup Wizard: Initial Topology dialog box, make sure that Create Empty Scenario is selected Ÿ Click Next Ÿ Select Campus from the Network Scale list Ÿ Click Next three times Ÿ Click OK.



Create and Configure the Network Initialize the Network: The slip8_gtwy node model represents an IPbased gateway supporting up to eight serial line interfaces at a selectable data rate. The RIP or OSPF protocols may be used to automatically and dynamically create the gateway's routing tables and select routes in an adaptive manner. The PPP_DS3 link has a data rate of 44.736 Mbps.



1. The Object Palette dialog box should now be on top of your project workspace. If it is not there, open it by clicking menu on the object palette.



. Select the routers item from the pull-down



a. Add to the project workspace eight routers of type slip8_gtwy. To add an object from a palette, click its icon in the object palette Ÿ Move your mouse to the workspace and click to place the object Ÿ You can keep on left-clicking to create additional objects. Right-click when you are finished placing the last object. 2. Switch the palette configuration so it contains the internet_toolbox. Use bidirectional PPP_DS3 links to connect the routers. Rename the routers as shown below. 3. Close the Object Palette and then save your project.
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Configure the Link Costs: 1. We need to assign link costs to match the following graph: 5
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2. Like many popular commercial routers, OPNET router models support a parameter called a reference bandwidth to calculate the actual cost, as follows: Cost = (Reference bandwidth) / (Link bandwidth) where the default value of the reference bandwidth is 1,000,000 Kbps. 3. For example, to assign a cost of 5 to a link, assign a bandwidth of 200,000 Kbps to that link. Note that this is not the actual bandwidth of the link in the sense of transmission speed, but merely a parameter used to configure link costs. 4. To assign the costs to the links of our network, do the following: i. Select all links in your network that correspond to the links with a cost of 5 in the above graph by shift-clicking on them. ii. Select the Protocols menu Ÿ IP Ÿ Routing Ÿ Configure Interface Metric Information. iii. Assign 200000 to the Bandwidth (Kbps) field Ÿ Check the Interfaces across selected links radio button, as shown Ÿ Click OK.



5. Repeat step 4 for all links with a cost of 10 but assign 100,000 Kbps to the Bandwidth (Kbps) field. 6. Repeat step 4 for all links with a cost of 20 but assign 50,000 Kbps to the Bandwidth (Kbps) field. 7. Save your project.



OSPF: Open Shortest Path First
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Configure the Traffic Demands: 1. Select both RouterA and RouterC by shift-clicking on them. i. Select the Protocols menu Ÿ IP Ÿ Demands Ÿ Create Traffic Demands Ÿ Check the From RouterA radio button as shown Ÿ Keep the color as blue Ÿ Click Create. Now you should see a blue-dotted line representing the traffic demand between RouterA and RouterC.



2. Select both RouterB and RouterH by shift-clicking on them. i. Select the Protocols menu Ÿ IP Ÿ Demands Ÿ Create Traffic Demands Ÿ Check the From RouterB radio button Ÿ Change the color to red Ÿ Click OK Ÿ Click Create. Now you can see the lines representing the traffic demands as shown.



3. To hide these lines: Select the View menu Ÿ Select Demand Objects Ÿ Select Hide All. 4. Save your project.
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Configure the Routing Protocol and Addresses: 1. Select the Protocols menu Ÿ IP Ÿ Routing Ÿ Configure Routing Protocols. 2. Check the OSPF check box Ÿ Uncheck the RIP check box Ÿ Uncheck the Visualize Routing Domains check box, as shown:



3. Click OK. Auto-Assign IP Addresses assigns a unique IP address to connected IP interfaces whose IP address is currently set to autoassigned. It does not change the value of manually set IP addresses.



4. Select RouterA and RouterB only Ÿ Select the Protocols menu Ÿ IP Ÿ Routing Ÿ Select Export Routing Table for Selected Routers Ÿ Click OK on the Status Confirm dialog box. 5. Select the Protocols menu Ÿ IP Ÿ Addressing Ÿ Select Auto-Assign IP Addresses. 6. Save your project.



Configure the Simulation Here we need to configure some of the simulation parameters:



1.



Click on



and the Configure Simulation window should appear.



2. Set the duration to be 10.0 minutes. 3. Click OK and then save your project.



OSPF: Open Shortest Path First
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Duplicate the Scenario In the network we just created, all routers belong to one level of hierarchy (i.e., one area). Also, we didn’t enforce load balancing for any routes. Two new scenarios will be created. The first new scenario will define two new areas in addition to the backbone area. The second one will be configured to balance the load for the traffic demands between RouterB and RouterH.



The Areas Scenario: 1. Select Duplicate Scenario from the Scenarios menu and give it the name Areas Ÿ Click OK. 2. Area 0.0.0.1: i. Select the three links that connect RouterA, RouterB, and RouterC by shiftclicking on them Ÿ Select the Protocols menu Ÿ OSPF Ÿ Configure Areas Ÿ Assign the value 0.0.0.1 to the Area Identifier, as shown Ÿ Click OK.



Loopback interface allows a client and a server on the same host to communicate with each other using TCP/IP.



ii. Right-click on RouterC Ÿ Edit Attributes Ÿ Expand the OSPF Parameters hierarchy Ÿ Expand the Loopback Interfaces hierarchy Ÿ Expand the row0 hierarchy Ÿ Assign 0.0.0.1 to the value of the Area ID attribute Ÿ Click OK.



3. Area 0.0.0.2: i. Click somewhere in the project workspace to disable the selected links and then repeat step 2-i for the three links that connect RouterF, RouterG, and RouterH but assign the value 0.0.0.2 to their Area Identifier.
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4. To visualize the areas we just created, select the Protocols menu Ÿ OSPF Ÿ Visualize Areas Ÿ Click OK. The network should look like the following one with different colors assigned to each area (you may get different colors though). Note: -



The area you did not configure is the backbone area and its Area Identifier = 0.0.0.0.



-



The figure shows the links with a thickness of 3.



The Balanced Scenario: 1. Under the Scenarios menu, Switch to Scenario Ÿ Select No_Areas. OPNET provides two types of IP load balancing: With Destination Based, load balancing is done on a perdestination basis. The route chosen from the source router to the destination network is the same for all packets. With Packet Based, load balancing is done on a per-packet basis. The route chosen from the source router to the destination network is redetermined for every individual packet.



2. Select Duplicate Scenario from the Scenarios menu, and give it the name Balanced Ÿ Click OK. 3. In the new scenario, select both RouterB and RouterH by shift-clicking on them. 4. Select the Protocols menu Ÿ IP Ÿ Routing Ÿ Configure Load Balancing Options Ÿ Make sure that the option is Packet-Based and the radio button Selected Routers is selected as shown Ÿ Click OK.



5. Save your project.



OSPF: Open Shortest Path First
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Run the Simulation To run the simulation for the three scenarios simultaneously: 1. Go to the Scenarios menu Ÿ Select Manage Scenarios. 2. Click on the row of each scenario and click the Collect Results button. This should change the values under the Results column to as shown.



3. Click OK to run the three simulations. Depending on the speed of your processor, this may take several seconds to complete. 4. After the three simulation runs complete, one for each scenario, click Close and then save your project.



View the Results The No_Areas Scenario: 1. Go back to the No_Areas scenario. 2. To display the route for the traffic demand between RouterA and RouterC: Select the Protocols menu Ÿ IP Ÿ Demands Ÿ Display Routes for Configured Demands Ÿ Expand the hierarchies as shown and select RouterA Æ RouterC Ÿ Go to the Display column and pick Yes Ÿ Click Close.
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3. The resulting route will appear on the network as shown:



4. Repeat step 2 to show the route for the traffic demand between RouterB and RouterH. The route is as shown below. (Note: Depending on the order in which you created the network topology, the other “equal-cost” path can be used, that is, the RouterB-RouterA-RouterD-RouterF-RouterH path).



The Areas Scenario: 1. Go to scenario Areas. 2. Display the route for the traffic demand between RouterA and RouterC. The route is as shown:



3. Save your project.
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The Balanced Scenario: 1. Go to scenario Balanced. 2. Display the route for the traffic demand between RouterB and RouterH. The route is as shown:



3. Save your project.



Further Readings −



OPNET OSPF Model Description: From the Protocols menu, select OSPF Ÿ Model Usage Guide.



−



OSPF: IETF RFC number 2328 (www.ietf.org/rfc.html).



Exercises 1) Explain why, for the same pair of routers, the Areas and Balanced scenarios



result in different routes than those observed in the No_Areas scenario. 2) Using the simulation log, examine the generated routing table in RouterA for



each one of the three scenarios. Explain the values assigned to the Metric column of each route. Hints: -



-



Refer to the View Results section in Lab 6 for information about examining the routing tables. You will need to set the global attribute IP Interface Addressing Mode to the value Auto Addressed/Export and rerun the simulation. To determine the IP address information for all interfaces, you need to open the Generic Data File that contains the IP addresses and associated with the scenarios.
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to build the directed graph of the network. Examine this database for RouterA in the No_Areas scenario. Show how RouterA utilizes this database to create a map for the topology of the network and draw this map (This is the map that will be used later by the router to create its routing table.)



Note: A stub network only carries local traffic (i.e., packets to and from local hosts). Even if it has paths to more than one other network, it does not carry traffic for other networks (RFC 1983).



Hints: - To export the link-state database of a router, Edit the attributes of the router and set the Link State Database Export parameter (one of the OSPF Parameters, under Processes) to Once at End of Simulation. - You will need to set the global attribute IP Interface Addressing Mode to the value Auto Addressed/Export. This will allow you to check the automatically assigned IP addresses to the interfaces of the network. (Refer to the notes of exercise 2 above.) - After rerunning the simulation, you can check the link-state database by opening the simulation log (from the Results menu). The link-state database is available in Classes Ÿ OSPF Ÿ LSDB_Export. 4) Create another scenario as a duplicate of the No_Areas scenario. Name the new



scenario Q4_No_Areas_Failure. In this new scenario simulate a failure of the link connecting RouterD and RotuerE. Have this failure start after 100 seconds. Rerun the simulation. Show how that link failure affects the content of the linkstate database and routing table of RouterA. (You will need to disable the global attribute OSPF Sim Efficiency. This will allow OSPF to updat the routing table if there is any change in the network.) 5) For both No_Areas and Q4_No_Areas_Failure scenario, collect the Traffic



Sent (bits/sec) statistic (one of the Global Statistics under OSPF). Rerun the simulation for these two scenarios and obtain the graph that compares the OSPF’s Traffic Sent (bits/sec) in both scenarios. Comment on the obtained graph.



Lab Report Prepare a report that follows the guidelines explained in Lab 0. The report should include the answers to the above exercises as well as the graphs you generated from the simulation scenarios. Discuss the results you obtained and compare these results with your expectations. Mention any anomalies or unexplained behaviors.



Laboratory
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Border Gateway Protocol (BGP) An Interdomain Routing Protocol Objective The objective of this lab is to simulate and study the basic features of an interdomain routing protocol called Border Gateway Protocol (BGP).



Overview



The Internet is organized as a set of routing domains. Each routing domain is called an autonomous system (AS). Each AS is controlled by a single administrative entity (e.g., an AS of a single service provider). Each AS has a unique 16-bit identification number. This number is assigned by a central authority. An AS employs its own intradomain routing protocol (e.g., RIP or OSPF). Different ASs establish routes among each other through interdomain routing protocols. The border gateway protocol (BGP) is one of the major interdomain routing protocols. The main goal of BGP is to find any path to the destination that is loop-free. This is different from the common goal of intradomain routing protocols, which is to find an optimal route to the destination based on a specific link metric. The routers that connect different ASs are called border gateways. The task of the border gateways is to forward packets between ASs. Each AS has also at least one BGP speaker. BGP speakers exchange reachability information among ASs. BGP advertises the complete path to the destination AS as an enumerated list. This way routing loops can be avoided. A BGP speaker can also apply some policies such as balancing the load over the neighboring ASs. If a BGP speaker has a choice of several different routes to a destination, it will advertise the best one according to its own local policies. BGP is defined to run on top of TCP and hence BGP speakers do not need to worry about acknowledging received information or retransmission of sent information. In this lab you will set up a network with three different ASs. RIP will be used as the intradomain routing protocol and BGP as the interdomain one. You will analyze the routing tables generated in the routers as well as the effect of applying a simple policy.
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Prelab Activities







Read section 4.3 from "Computer Networks: A Systems Approach", 4th Edition. Go to www.net-seal.net/animations.php and play the following animation: - IP Subnets.



Procedure Create a New Project 1. Start OPNET IT Guru Academic Edition Ÿ Choose New from the File menu. 2. Select Project and click OK Ÿ Name the project _BGP, and the scenario No_BGP Ÿ Click OK. 3. In the Startup Wizard: Initial Topology dialog box, make sure that Create Empty Scenario is selected Ÿ Click Next Ÿ Select Campus from the Network Scale list Ÿ Click Next three times Ÿ Click OK.



Create and Configure the Network Initialize the Network: 1. The Object Palette dialog box should now be on top of your project workspace. If The ethernet4_slip8_ gtwy node model represents an IP-based gateway supporting four Ethernet hub interfaces and eight serial line interfaces. IP packets arriving on any interface are routed to the appropriate output interface based on their destination IP address.



. Make sure that the internet_toolbox is it is not there, open it by clicking selected from the pull-down menu on the object palette. 2. Add to the project workspace the following objects from the palette: six ethernet4_slip8_gtwy routers and two 100BaseT_LAN objects. a. To add an object from a palette, click its icon in the object palette Ÿ Move your mouse to the workspace Ÿ Click to place the object Ÿ Right-click to stop creating objects of that type. 3. Use bidirectional PPP_DS3 links to connect the routers you just added as in the following figure. Also, rename the network objects as shown (right-click on the node Ÿ Set Name). 4. Use a bidirectional 100BaseT link to connect LAN_West to Router1 and another 100BaseT link to connect LAN_East to Router6 as in the following figure. 5. Close the Object Palette dialog box. 6. Save your project.



Border Gateway Protocol (BGP)
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Routers Configuration:



Redistribute w/ Default. allows a router to have a route to a destination that belongs to another Autonomous System



1. Highlight or select simultaneously (using shift and left-click) all six routers Ÿ Right-click on any router Ÿ Edit Attributes Ÿ Check the Apply Changes to Selected Objects check box. 2. Expand the BGP Parameters hierarchy and set the following: i. Redistribution Æ Routing Protocols Æ RIP Æ Redistribute w/ Default. 3. Expand the IP Routing Parameters hierarchy and set the following: i. Routing Table Export = Once at End of Simulation. This asks the router to export its routing table at the end of the simulation to the simulation log. 4. Expand the RIP Parameters hierarchy and set the following: i. Redistribution Æ Routing Protocols Æ Directly Connected Æ Redistribute w/ Default. 5. Click OK and then save your project.



Application Configuration: 1. Right-click on LAN_West Ÿ Edit Attributes Ÿ Assign All to Application: Supported Services Ÿ Assign West_Server to the LAN Server Name attribute as shown Ÿ Click OK. Notice that two objects for Applications and Profiles will be added automatically to the project.
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2. Right-click on LAN_East Ÿ Edit Attributes: i. Expand the Application: Supported Profiles hierarchy Ÿ Set rows to 1 Ÿ Expand the row 0 hierarchy Ÿ Set Profile Name to E-commerce Customer. ii. Edit the Application: Destination Preferences attribute as follows: Set rows to 1 Ÿ Set Symbolic Name to HTTP Server Ÿ Edit Actual Name Ÿ Set rows to 1 Ÿ In the new row, assign West_ Server to the Name column. 3. Click OK three times and then save your project..



Configure the Simulation Here we need to configure some of the simulation parameters: 1.



Click on



and the Configure Simulation window should appear.



2. Set the duration to be 10.0 minutes. 3. Click on the Global Attributes tab and make sure that the following attributes are assigned as follows:



Border Gateway Protocol (BGP)



Auto Addressed means that all IP interfaces are assigned IP addresses automatically during simulation. The class of address (e.g., A, B, or C) is determined based on the number of hosts in the designed network. Subnet masks assigned to these interfaces are the default subnet masks for that class.
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a. IP Interface Addressing Mode = Auto Addressed/Export. b. IP Routing Table Export/Import = Export. c.



RIP Sim Efficiency = Disabled. If this attribute is enabled, RIP will stop after the "RIP Stop Time." But we need the RIP to keep updating the routing table in case there is any change in the network.



4. Click OK and then save the project.



Export causes the autoassigned IP interface to be exported to a file (name of the file is ip_addresses.gdf and gets saved in the primary model directory).



Choose the Statistics 1. Right-click on LAN_East and select Choose Individual Statistics from the popup menu Ÿ From the Client HTTP hierarchy choose the Traffic Received (bytes/sec) statistic Ÿ Click OK. 2. Right-click on the link that connects Router2 to Router3 and select Choose Individual Statistics from the pop-up menu Ÿ From the point-to-point hierarchy choose the “Throughput (bits/sec) -->” statistic Ÿ Click OK. Note: If the name of the link is “Router3 Router2” then you will need to choose the “Throughput (bits/sec) ” statistic Ÿ Click OK. Note: If the name of the link is “Router4 Router2” then you will need to choose the “Throughput (bits/sec) 
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